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1 Introduction 

1.1 Overview 
Automation Xpress is an easy to use application development tool for use with Giga-tronics 24XX/25XX 
Series Microwave Synthesizers and Automation Xpress Interface. Automation Xpress offers fast remote 
operation that goes beyond just fast frequency switching. 
 
The AXI ensures very fast remote programming using Automation Xpress from any ATE/TPS program to 
a 24XX/25XX series instrument, providing faster CW frequency switching time, faster overall download, 
and faster function execution times of large amounts of data. The transit and execution times for single 
function calls, such as changing CW frequency is 10 X faster than sending the command via standard 
message based commands. With Automation Xpress now sending large amounts of data, such as large 
lists, the transit and execution times are > 100X faster as compared to SCPI. This makes lengthy and 
repetitive tasks faster and more efficient, maximizing test throughput, while minimizing testing time and 
system downtime. Automation Xpress provides the tools necessary to successfully program the 
24XX/25XX series. The Xpress Auto-programmer can virtually eliminate the need for training, providing 
programming scripts and sequences that are guaranteed for accuracy. 
 
Automation Xpress eliminates the need for you to learn the various GPIB commands. With a click of the 
mouse, the Auto-Programming feature automatically records the sequence of your actions and converts 
those actions into program code. Auto-programming provides the option of seamlessly converting the 
recorded action sequence into a generated program that can be imported into to the program environment 
of your choice, such as Visual C++ and Visual Basic. Auto-programming generates the same results as 
the action sequence created manually. The value is a reduction in test downtime, reduced programming 
costs, and greater profitability. 
 
The key to reducing the cost of testing is faster frequency switching. The 24XX/25XX Series Microwave 
Synthesizer offers unmatched frequency and power switching in list mode; however this approach may 
not be suitable for some remote programming situations. Automation Xpress combined with the 
Automation Xpress Interface option ensures unmatched 2.5 ms CW frequency and power switching 
performance, providing fast and flexible data exchange rates for faster testing and more device 
throughput. 
 

1.2 Document Summary 
This document contains Getting Started section and Automation Xpress graphic user interface window 
section. The Getting Started section includes the software installation and uninstallation. Automation 
Xpress graphic user interface window section describes the user interface windows in details. The user 
interface windows are Main window including menu bar, toolbar, navigation and message windows, CW 
window, List window, Modulation window including Amplitude Modulation, Frequency Modulation, 
Phase Modulation and Pulse Modulation window, Advanced Setting window, Interface window, General 
Info window, Command Interpreter, Auto programmer windows and Firmware Download window. 
 
Please refer to GT2400 and 2500 Series Microwave Signal Generators Programmer Manual for the 
Dynamic Link library or DLL functions details. 
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2 Getting Started 
The Automation Xpress (AX) user guide teaches you how to use and integrate Giga-tronics advanced 
Automation Xpress software into your programming environment. This user guide provides detailed 
description of the AX Graphical User Interface (GUI). 
 
You will learn step-by-step instructions for using the Automation Xpress Auto-Programming feature for 
advanced programming in Visual C++. 
 

2.1 Package Contents 
The Automation Xpress software package includes the following software and documentation: 

• Automation Xpress CD-ROM(Part#33478) 
• USB Port Adapter and USB driver software (included in Automation Xpress CD).  
• Automation Xpress User Guide (Part #33484)  
• GT2400 and 2500 Series Microwave Signal Generators Programmer Manual. 

 
The Automation Xpress CD contains everything you need to install and run the Automation Xpress 
application, such as the Automation Xpress Installer, the USB device, and the help document files. 
 
For information about the software and hardware you need to use Automation Xpress, see the Install 
ReadMe file on the CD. 
 
To install and run Automation Xpress software and use the USB Port adapter, you must-have the 
following hardware and software: 
 

• An IBM-compatible PC  
• Microsoft Windows 2000, or Window XP  
• CD-ROM drive, 4X or better  
• USB V.1.1 or above compliant port  
• At least 20MB of disk space 
• 128 MB RAM or greater recommended  
• National 2400s IEEE-488.2 GPIB Interface Card  
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2.2 Installation and Uninstallation 
 
To install Automation Xpress software, follow the steps below: 
 

1. Insert the Automation Xpress CD into the CD/DVD drive.  
2. Click on My Computer and select the drive with the Automation Xpress CD. 
3. Double click the AX setup.exe file. 

 
The following installation screen will appear: 
 

 
 

4. Click NEXT.  
5. The Automation Xpress installation process will begin.  
6. The Setup program begins installing the Automation Xpress software (please note that without 

Option 48 installed on the 2400/2500 Series, the setup program will automatically install the 
basic version of the Automation Xpress software).  

7. In the Choose Automation Xpress destination location dialog, select the location where you want 
the software to be installed.  

8. Click NEXT to accept the default location (recommended) 
OR 

9. Enter the directory location where you want the Automation Xpress software to install and then 
click NEXT.  

10. In the Setup Type dialog box, select the type of installation you would like to perform and then 
click NEXT.  

• Full Setup Type installs all the required Automation Xpress files (recommended). 
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• Custom Setup Type allows you to choose which components you would like to install.  
11. When the Automation Xpress Installation is complete, the Setup Complete dialog box appears. 

Click FINISH.  
12. After Automation Xpress has successfully installed onto your PC, you can click FINISH or 

continue with the USB Driver installation.  
 

2.3 Installing the USB Device and Drivers 
The USB to Serial Cable Port Adapter provides you the simplest way to attach Notebook or Desktop 
computer to the 2400/2500 Series Microwave Synthesizer. This portable expansion cable directly 
connects to your computer via a Universal Serial (USB) port. This section of the Automation Xpress 
user’s guide describes how to connect adapter to your computer, install software and hardware drivers, 
and attach and configure devices. 
 
To use the USB Port Adapter, you must first install the USB Port Adapter driver software onto your 
computer. Then, you can connect it to your computer and install hardware drivers for the adapter’s 
port(s). 
 

WARNING: YOU MUST INSTALL THE DRIVER 
SOFTWARE BEFORE CONNECTING THE 
ADAPTER TO YOUR COMPUTER. 
OTHERWISE THE ADAPTER WILL NOT WORK CORRECTLY. 
 
 

 

2.3.1 Installing the USB Driver with Automation Xpress Installation  

• After Automation Xpress has installed, click Install USB  
• Follow the instructions for the next screens 

 
You must restart you computer for the USB Adapter driver to function. You can restart your PC 
immediately or at a later time. 
 

2.3.2 USB Driver Installation from the Automation Xpress Directory 

If the USB Adapter driver was not installed at the time of the Automation Xpress installation, it can be 
installed from the Automation Xpress directory. 
 

• Using the Windows Explorer, locate the Automation Xpress directory  
• Select the USB Driver folder and open  
• Double click on the Setup.exe file and begin the USB driver installation 

 

2.3.3 Removing the USB Driver  

Conflicts with other USB/RS-232 drivers can occur if a similar driver is already installed or is going to be 
installed. It is recommended that the same Make and Manufacturer USB adapter be used on your PC only. 
To remove the USB Adapter driver, perform the following: 
 

• Using Windows Explorer, locate the Automation Xpress directory.  
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• Select the USB Driver folder and open.  
• Double click on the Setup.exe file and begin the USB driver installation  

 
The installation utility will recognize that a USB adapter has previously been installed. The installation 
utility will ask if you want to remove the driver. 
 

2.3.4 Removing the USB Driver  

Conflicts with other USB/RS-232 drivers can occur if a similar driver is already installed or is going to be 
installed. It is recommended that the same Make and Manufacturer USB adapter be used on your PC only. 
To remove the USB Adapter driver, perform the following: 
 

• Using Windows Explorer, locate the Automation Xpress directory.  
• Select the USB Driver folder and open.  
• Double click on the Setup.exe file and begin the USB driver installation  

 
The installation utility will recognize that a USB adapter has previously been installed. The installation 
utility will ask if you want to remove the driver. 
 

2.4 Uninstall Automation Xpress 
To uninstall Automation Xpress from your computer, do either following: 
 

1. Click the WINDOWS > START button and choose SETTING > CONTROL PANEL.  
2. In the control panel, click ADD/REMOVE PROGRAMS. 
3. From the REMOVE PROGRAMS properties dialog box, select Automation Xpress and 

REMOVE.  
OR 

 
1. Insert the Automation Xpress CD into CD drive.  
2. Double click on the Automation Xpress Installation program.  
3. Click on the "Uninstall Giga-tronics Automation Xpress from this computer" and click NEXT 

continue.  
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2.5 Starting Automation Xpress 
You start Automation Xpress just as you would any software application. 
 
To start Automation Xpress in Windows: 
 

1. Choose START> PROGRAMS> Gigatronics-MSS> AX. The Automation Xpress registration 
window will appear.    

2.6 Registering Automation Xpress  
 
Registering your software helps Giga-tronics offer technical support and inform you about new software 
developments. You can register quickly by using the registration screen that appears when you first start 
Automation Xpress. In addition, you can choose to register at any time by choosing HELP > REGISTER 
Automation Xpress. This registration requires that you be connected to the Internet, as it opens the Giga-
tronics registration Web page. You can also register by phone, mail or email. 
 

• Click REGISTER ONLINE, to register your Automation Xpress software online 
OR  
• Click REGISTER BY MAIL, to register your Automation Xpress software by mail.  
• Register your software to receive notification of product updates and to be eligible for technical 

support.  
 
 

2.6.1 Registering by mail or Fax:  

• Open HELP> REGISTER BY MAIL. The Automation Xpress registration by mail dialog box 
appears.  

• Enter your name, address, phone, and fax in the edit boxes provided, and click OK when finished.  
• Click the PRINT REGISTRATION FORM button. Automation Xpress prints out a copy of your 

completed registration form. 
• Fax the form to Giga-tronics at the number that appears on the form, or mail it to the Giga-tronics 

address that appears on the form. 
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2.7 Getting Help 
 
Automation Xpress includes complete documentation in the Help section located on the-menu bar under 
Help, including all the information in this user guide, plus tutorials. 
 
To get Help about Automation Xpress: 

1. On the Automation Xpress Main window, click the HELP drop down menu.  
2. The list of Help topics appears. 
3. You can use the CONTENTS tab in HELP to find topics grouped by subject, or use the INDEX 

tab to search for information by typing in a subject, title, or specific word or phrase. 
4. To return to the list of topics after reading about a specific topic, click HELP TOPICS. 

 

2.8 Learning Automation Xpress 
 
A variety of resources are available to help you learn Automation Xpress, including this user manual, 
GT2400 and 2500 Series Microwave Signal Generators Programmer Manual and a help system with 
tutorials you can launch from the Automation Xpress application. The Automation Xpress Help Tutorial 
is a series of short, lessons that focus on specific Automation Xpress features and operations, from the 
basics of how to create and download lists to Auto-Programming. 
 
The Automation Xpress application contains dialog boxes and ToolTips designed to assist you in using 
the program. ToolTips appear when your pointer pauses over a user interface element. 
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2.9 Interfaces 
The 2400/2500 series allow a user to remotely control the instrument from a computer through GPIB, RS-
232, USB or Ethernet cables 
 

2.9.1 GPIB 

The 2400/2500 series permits data bus control in accordance with the IEEE Standard Digital Interface for 
Programmable Instruments, IEEE STD 488.2.  Table 1, shows the IEEE 488 standard subsets that are 
implemented in the 2400/2500. 
 

Table 1: Implemented IEEE 488 Subsets 
 

 Subset Title Implementation 
    

   

 SH1 Source Handshake Complete Capability 
 
   
 AH1 Acceptor Handshake Complete Capability 
 
   
 T8 Talker Basic Talker 
 
   
 TEO Extended Talker No Capability 
 
   
 L4 Listener Basic Listener 
 
   
 LEO Extended Listener No Capability 
 
  
 SRO Service Request Complete Capability 
 
   
 RL2 Remote/Local Complete Capability 
 
   
 PPO Parallel Poll Complete Capability 
 
   
 DCO Device Clear No Capability
 
   
 DTO Device Trigger Complete Capability 
 
   
 CO Controller No Capability 
    

 
 
The GPIB address is assigned from the front panel of the instrument. The available range of addresses is 1 
through 30. 
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2.9.2 RS-232 

2.9.2.1 Comport Settings 
The default settings for the 2400/2500 synthesizer is as follows. 

 

Parameter Setting 
  
 

Baud Rate 115200
 

Data Bits 8
  

Parity No
  

Stop Bits 1
  

Handshake None
 

 
There is no manual panel control for changing any of these settings. RS-232 port settings can be changed 
using the Automation Xpress software or via remote commands (see SYST:COMM commands in the 
SCPI command section for details). All remote commands must be terminated with a line feed (ASCII 
character 10). 
 

2.9.3 USB 

A USB cable can be selected to remotely control the instrument.  An appropriate COM port must be 
chosen for the USB connection. 

2.9.4 Ethernet 

To establish an Ethernet connection, please select an IP address. 
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3 Automation Xpress Graphic User Interface 
This section describes the graphic user interface windows in details. The user interface windows are Main 
window including a menu bar, a toolbar, navigation and message windows, CW window, List window, 
Modulation window including Amplitude Modulation, Frequency Modulation, Phase Modulation and 
Pulse Modulation window, Advanced Setting window, Interface window, General Info window, 
Command Interpreter, Auto programmer windows and Firmware Download window. 

3.1 Main Window 
The Automation Xpress Main window appears automatically when the software is launched. The Main 
window is easy to understand and use. The Main window consists of a menu bar at the top of the work 
area, a toolbar below the menu bar, a large work area, a navigation window, a message display window 
and a status bar located at the bottom. The large work area provides an area for the multiple Automation 
Xpress windows to open in. The following figure shows each area of the Main window. 
Menu Bar Navigation Window Toolbar       LED Indicators Work Area 
 

 
   Figure 1 Main window 

Status Bar Message Window 
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3.1.1 Menu Bar 

The Menu bar is the Automation Xpress command center. The Menu bar contains menus and drop down 
submenus of all the commands available in Automation Xpress. The menus will change depending on 
what window you are currently in. 

3.1.1.1 File 
Name Description 
Open Opens a saved file into the Main work area. 
New List Creates a list in the List Controller window. 
Save List Saves the current list in the List Controller window to a file. 
Save List As Saves the current list in the List Controller window to a new file. 
Close List Closes the current list. 
Close All Lists Closes all the lists. 
Exit Exits the Automation Xpress Software program. 
 
 

3.1.1.2 Edit 
Name Description 
Cut Cuts the contents of the current selection to the clipboard. 
Copy Copies the contents of the current selection to the clipboard.
Paste Pastes the clipboard information into the selection. 
 

3.1.1.3 View 
Name Description 
Toolbar Show/Hide the Automation toolbar. 
Status Bar Show/Hide the Automation status bar. 
Navigation 
Window Show/Hide the Navigation window. 
Message Window Show/Hide the Message window. 
Web Browser Opens the Microsoft Explorer web browser. 
 

3.1.1.4 Operation 
Name Description 
CW Mode Opens the CW Mode window saved file into the Main work area. 
List Mode Displays the Operations windows. 
  List Editor Opens the List Editor window. 
  List Controller Opens the List Controller window 
Modulation Displays the Modulation windows.  
  Amplitude Mod Opens the Amplitude Modulation window 
  Frequency Mod Opens the Frequency Modulation window. 
  Phase Mod Opens the Phase Modulation window. 
  Pulse Mod Opens the Pulse Modulation window. 
  Scan Modulation Opens the Scan Modulation window.
Advanced Opens the Advanced Settings window. 
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3.1.1.5 System 
Name Description 
Interface Opens the Connection Interface Window. This option is only available when navigating in the 

Control tab. 
General Information Opens the General Information window. This option is displayed when navigating in the Control tab.
 

3.1.1.6 Tools 
Name Description 
Command 
Interpreter Opens the Command Interpreter window.
Cmd  Auto-
programmer Opens the Auto Programmer window to be used with SCPI or GT12000 (Native) script. 
VC ++ Auto-
programmer Opens the Auto Programmer window to be used with Microsoft Visual C++. 
VB Auto-
Programmer Opens the Auto Programmer window to be used with Microsoft Visual Basic. 
 

3.1.1.7 Windows 
Name Description 
Close All Closes all open windows.
Cascade Arranges all windows into a stack, with each window offset slightly. 
Tile Horizontal Arranges all windows to overlap horizontally. 
Tile Vertical Arranges all windows to overlap vertically. 
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3.1.2 Toolbar 

The toolbar contains buttons that operate as shortcuts to menu commands. Below is a description of each 
button and what the button controls. The Automation Xpress Toolbar allows you to set up the Automation 
Xpress Operations window. Common features provided in the Menu bar drop down menus, can also be 
selected by clicking on the appropriate icon on the Toolbar.  
 
Position your mouse pointer over a tool or control and pause. A tool tip appears showing the name and 
keyboard shortcut (if any) for the item. 
 

 
 
Icon Description 

 Opens a list file. 

 Saves a list to a file. 

 Show/Hide the Navigation window. 

 Opens and closes the Message Display Area. 

 Opens the CW Mode window. 

 Opens the List Controller window. 
 Opens the List Editor window. 

 Opens the Amplitude Modulation window. 

 Opens the Frequency Modulation window. 

 Opens the Pulse Mode window. 

 Opens the Scan Modulation window. 

 Opens the Advanced Settings window. 

 Opens the System Interface window. 
Opens the General Information window. 

 Opens the Command Interpreter window. 
 Opens the Help Menu. 
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3.1.3 LED Indicators 

The LED indicators ensure and deliver testing confidence. The status LED indicators displays the 
conditions of the communications link between the controller and the 2400/2500, the Lock and Level 
condition of the current RF setting, the source of the synthesizer time base reference, and the state of the 
RF output. Control of the output is also located on the LED Indicator Toolbar. The toggle control is used 
to enable or disable the generator output. Click the RF On/Off button to enable and disable the RF output. 
 

 
 
Name Description 
No Connection A green LED indicates that Automation Xpress has established Communication with the 

2400/2500. A red LED indicates Automation Xpress is not communicating with the 
instrument. 

Unlocked Displays Unlock status. A gray LED (normal mode) indicates the frequency is locked. A 
yellow LED (warning mode) indicates that the frequency is unlocked. 

Unleveled Displays Unleveled status. A gray LED (normal mode) indicates that the power is leveled. A 
yellow LED (warning mode) indicates that the frequency is un leveled. 

Oven Cold Display Oven Cold status. A gray LED (normal mode) indicates oven is warm. A yellow 
LED (warning mode) indicates that oven cold is detected. 

Ext Ref Displays the External Reference status. A blue LED indicates that an external reference is 
detected and the instrument locked to it. A gray LED indicates that there is no external 
reference. 

Ext. ALC Displays the External ALC status. A blue LED indicates that an external ALC is detected. A 
gray LED indicates that there is no external ALC. Select Power Meter, Positive Diode or 
Negative Diode under Advanced Settings window to set external ALC indicator to blue. 

RF ON/OFF Turns RF On/Off. A blue LED indicates the RF is on. A gray LED indicates the RF is off. 
AM LED Displays the AM status. A gray LED indicates the amplitude modulator is off. A blue LED 

indicates the amplitude modulator is on. 
FM LED Displays the FM status. A gray LED indicates that the frequency modulator is off. A blue 

LED indicates the frequency modulator is on. 
PhM LED Displays the phase modulation status. A gray LED indicates that the phase modulator is 

off. A blue LED indicates the phase modulator is on. 
Pulse LED Displays the Pulse status. A gray LED indicates the pulse modulator is off. A blue LED 

indicates the pulse modulator is on. 
PB On/Off Turn power boost On/Off. A blue LED indicates the power boost is on. A gray LED indicates 

the power boost is off. 
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3.1.4 Navigation Window 

The Navigation window provides a tree structure of Automation Xpress. The Navigation window enables 
you to quickly navigate between the different Automation Xpress control windows. The Navigation 
window consists of two separate tabbed menus, Control and Service. The control and service tabs are 
arranged by functionality. When an item is selected from the Navigation window, the corresponding 
window will open in the main work area. You can SHOW and HIDE the Navigation window at any time 
by selecting VIEW>Navigation Window. The following sections provide a detailed description on the 
Control and Service Tab windows. 
 

 
     Figure 2 Navigation window 

 
  Control Tab Service Tab 
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3.1.5 Message Window 

The Message window displays the status messages from the instrument. The Message window is divided 
into a left and right side. The left side of the Message window displays the system status messages, 
warning messages and error messages. The right side of the Message window is referred to as the 
Communication message area. The Communication message area displays the Tx/Rx messages. You can 
clear all messages displayed in the left message window at any time by selecting the Clear message icon. 
To clear all messages in the Communication message area, click Clear msg bar. 
 

 
Figure 3 Message window 

Clear message icon   Status bar 
 

3.1.6 Status Bar 

The Status bar shown in the above figure is used to display the current system connection status. Panel 
one of the status bar displays the connected GPIB address or a COM port number of the serial port. The 
Status bar also displays the DEMO MODE, if there is no connection with the instrument. Panel two of the 
status bar displays GT2400 or GT2500. 
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3.2 Control Tab Windows 
The Control tab is located on the bottom of the Navigation window. Click Control tab to allow you to 
select basic operation windows. 

3.2.1 Operation 

3.2.1.1 CW Mode 
The CW Mode window combined with the List Controller window provides a powerful combination for 
faster and more efficient synthesizer operation. Unlike the common front panel operation, the CW Mode 
leverages the streamlined Windows familiar environment, improving testing throughput and performance.  
 
In CW Mode, you can set the frequency and power quickly with your mouse. Eliminate the tedious task 
of entering numbers individually from the front panel. With a click of your mouse, you can send 
commands directly to the instrument effortlessly.  For models with option 26, 90 dB step attenuator, you 
can manually control the step attenuator or let the 2400/2500 automatically switch the attenuator. 
 

 
Figure 4 CW Mode window 

 
Name Description 
Frequency Lets you input CW frequency directly or use the up/down arrow keys to change the value of 

the frequency. 
Frequency Unit Lets you select the units for frequency. 
Power Level Lets you input power directly or use the up/down arrow keys to change the value of the 

power. 
Manual 
Attenuation 

Lets you select the manual attenuation value when the manual attenuation radio button is 
selected under Attenuation. After the manual attention radio button is selected you can then 
set the amount of attenuation using the Attenuation drop down box. In manual attenuation 
mode, the output power range will be limited to a 45db settable range around the attenuator. 
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Attenuation This section controls the step attenuator state when option 26 is installed in the 2400/2500 
synthesizer. The attenuator can be set to automatically switch or to be controlled manually. 
The step attenuator has a 90 dB range and switches in 10 dB steps. The maximum settable 
range in automatic mode is -110 dBm to +25 dBm. The maximum settable range in manual 
mode is 40 dB. 

Auto Selecting auto attenuation causes the step attenuator to automatically switch at specific power 
levels for the full range of the synthesizer. 

Manual Selecting manual attenuation control prevents the step attenuator from automatically 
switching to a new state when a new power level is selected. 

  
 

3.2.1.1.1 Setting Parameters in the CW Mode Window 
 
Editing frequency, power, and step attenuator control and settings are performed with the CW Mode 
window. The power setting is always entered in dBm units. 
 
 

1. Double clicking on the CW Mode icon in the Navigation window opens the CW Mode window.  
2. Using your mouse, highlight the field you would like to change. Either by positioning your 

mouse on the desired digit to adjust and using the Up/Down arrows located on the right side of 
the text box to increase or decrease the value. Or by directly high-light the field you would like to 
change and type your number directly, then press enter.  

3. To change the step size in the text box, highlight the desired step size digit. Double-clicking on 
the field will select the entire value to the decimal point. To select the entire number, click and 
drag the mouse over the entire field. The field can also be changed using the numeric keypad on 
the controller keyboard. All or part of the field can be changed depending on the section of the 
number that is highlighted. 

 
Pressing enter on your keyboard, changing the frequency unit, or using the up/down keys will send a 
command from your computer to the instrument. 

3.2.1.1.2 Step Attenuator Control (Option 26) 
The step attenuator is controlled manually or automatically. Under certain conditions, it is desirable not to 
have the step attenuator automatically switch. The first switch point is at -5 dBm. Additional switch 
points occur at 10 dB increments starting with -5 dBm to the minimum setting of the 2400/2500. The 
Manual Attenuation drop down box will display the current state of the step attenuator when the 
Attenuation field is set to Manual Mode. 
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3.2.1.2 List Mode 
The List Mode Operation consists of two list windows, the List Controller window and the List Editor 
Window. The List Controller window is used to manage and run lists. The List Editor window is used to 
create new lists, add new points to an existing list or delete one or more points in a selected list. Once a 
list is loaded into the List Controller window, individual points can be modified. There is no limitation for 
the number of lists stored in Automation Xpress, however only one list can be stored in the 2400/2500 
synthetic instrument. 
 
Automation Xpress offers three distinct methods for creating lists. You can create a list by: 

1. Creating a list using Automation Xpress’s List Controller window.  
2. Creating a list using Automation Xpress’s  List Editor window. 
3. Importing a list you created in Microsoft Excel or a text editor program. 

 
The following sections describe how to use List Controller and the List Editor Windows in details. 

3.2.1.2.1 About List Operation 
The list operation is an operation that executes a series of pre-programmed instrument states (points). The 
list is capable of storing more than 4000 points. Each point in the list defines the GT2400/2500 
frequency, power, sync output conditions for a fixed period of time (step time), as shown in the following 
figure. A remote command or external TTL trigger can be used to initiate the list. Only one list can be 
stored in the 2400/2500 at any one time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Figure 5 List Attributes 
 

3.2.1.2.2 List Controller 
The List Controller window is used to manage and run lists. In the List Controller window, you can create 
a new list or open a file to load a list. The List Controller also allows you to specify how a list is executed 
by controlling features such as step time repeat mode and trigger type. The list can be edited using either 
this window or the List Editor window. 
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Figure 6 List Controller window 

             
       List Data Field 
 
Name Description 
List Table The list table displays all existing list names. Here you can select the current running list. 

You can also select a new list from the File Menu to add a new list file name to the box or 
right click your mouse button to add a new list name to the box. Select Open List from File 
Menu to add a list file name with the path to the box. 

Trigger button Click to trigger the list. The type of trigger is defined by the trigger type. 
Download List 
button 

Downloads the selected list to the instrument. 
 

Sweep Direction Lets you set the direction of the list sweep. The list can be swept in forward or reverse 



                                  

 Page | 25 33486 Rev.C / US090922  

direction. 
Attenuator Setting Sets the attenuation of the instrument. 
Power Meter 
Address 

Input Giga-tronics 86xx Power Meter Address 
 

Get Correction 
Button 

Click the button to generate list correction data. Create a list first. Connect the instrument to 
an 86xx power meter with an appropriate GPIB address. Click the button to generate list 
correction data and update the Correction (dBm) column of the List Data Field. 

Repeat Type Lets you set the repeat list mode parameters for the current list. This determines how a list 
will be executed. There are three repeat mode options to select from. 

      Single Step 
 

Lets you execute the list one point at a time. Each point in the list is executed for each trigger 
received. 

      Single Sweep Lets you execute the list one point at a time. Each point in the list is executed for each trigger 
received. 

      Continuous This option will immediately execute the current running list, repeating it indefinitely. 
Trigger Type Sets the type of trigger to initiate a list. 
      BNC Sets the trigger type to BNC. A list will be triggered whenever a TTL signal is received at the 

external Trigger In BNC on the rear panel of the 2400/2500. 
      GPIB 
Command 

Sets the trigger type to GPIB. Clicking the trigger button will issue a single 2400/2500 
trigger. 

      Group 
Execution 

Sets the trigger type to Group Execution. Clicking the trigger button will trigger all 
2400s/2500s on the GPIB bus. 

Step Time Type Select Step Time Type. It contains two options. 
  Global Step Time All step time (Dwell time) of a list is the same value. 
  Individual Step   
  Time 

Let a user to set the individual selected step time (Dwell time). This selection enables Dwell 
time text box to allow a user to input Dwell time of selected list point. 

Step Time Sets the step time for all list points. Units are in (ms). 
RF Off Time Sets the RF Off time for all list points. Units are in (ms).
Sync Out Delay Sets the delay of the sync output. Units are in (ms). 
Current List Points The Current List Point field allows you to modify an individual list point in the active list. 
      Add Before Lets you add a list point before the selected list item in the List Data Field. 
      Update Lets you modify the frequency and power of the selected list item in the List Data Field. 

First, select the list point you would like to modify, then modify the frequency and power 
input parameters. 

      Add After Click to add a list point after the selected list item in the List Data Field. 
      Delete Click to delete the selected list point in the current list. 
Sync Out Sync out can be set for every list point. (Sync out pulse is generated in checked points). 
Frequency Lets you input a frequency value for a newly added list point. Frequency units are in MHz. 
Power Lets you input a power value for a newly added list point. Power units are in dBm. 
Correction Default value is 0 dBm. If you want to correct the data, click Get Correction button to 

generate list correction data and update the Correction (dBm). 
Dwell time Lets you input a Dwell time value for a newly added list point. Units are in ms. Select 

Individual Step Time under Step Time Type to enable Dwell time text box input. 
List Data Field Displays individual list point information of the active list. 
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3.2.1.2.3 List Editor 
The List Editor window provides a useful way to create or insert a range of list points to your current 
running list. The List Editor window contains two tabbed sets of controls: List Range and Selected Points. 
The List Editor edits the list that is currently selected in the List Controller window. 
 
List Range Tab 
 
Clicking on the List Range tab will open all the List Range controls. The List Range controls lets you add 
a range of points that step in value from a starting to an ending value. This range of points can be a 
frequency range at a specific power value or a power range at a specific frequency value. In addition, you 
can choose to add these points above or below or even to replace the point/s selected in the List Controller 
window. 
 

 
Figure 7 List Editor – List Range tab window 

 
Name Description 
Range Type Lets you create or insert a frequency or power list range. 
Start Input Field Lets you input the list range starting point. 
Stop Input Field Lets you input the ending list range point. 
Step Input Field Lets you input the step parameter for list creation. 
Power/Frequency 
Input 

Lets you set the power or frequency for all created list points. 
 

Apply Button Updates the current list with the new list range information. 
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Replacement Lets you select the replacement type for adding list Points. There are three list replacement 
options. 

      Replace Selecting this option will replace your current running list with the newly configured list.
      Insert Before Selecting this option will insert the new range of list points before the selected list item in the 

List Data Field. 
      Insert After Selecting this option will insert the new range of list points after the selected list item in the 

List Data Field. 
Step Time (ms) Sets the step time for all list points. Units are in (ms). 
Increment Option Lets you insert list points by either step size or by the number of list points. 
      Step Lets you specify the step size for list creation. 
      # of Points Lets you specify the number of points for the list range. Software determines the step size of 

the list using the following formula: 
STOP PARAMETER - START PARAMETER 
 
# OF POINTS 

# of List Points Lets you enter the number of list points for list range calculation. 
 



                                  

 Page | 28 33486 Rev.C / US090922  

Selected Point Tab 
 
Clicking on the Selected Points tab will display all of the Selected Point controls. The Selected Point tab 
enables you to update the frequency and power values of the points selected in the List Controller 
window. You can also select or unselect BNC Sync Out for the selected points. 
 

 
Figure 8 List Editor – Selected Points tab window 

 
Name Description 
Selected Point # Lets you select a list point(s) from the List Controller window and edit the frequency and 

power parameters. 
Frequency Input 
Field 

Lets you set the frequency for the selected list point(s) in the List Controller window. 
 

Power Input Field Lets you select the power for the selected list point(s). 
BNC Sync Out Lets you set the BNC Sync Out for the selected point(s). 
Apply Button Applies the changes to the selected list point(s). 
Delete Points Deletes the selected point(s). 
 

3.2.1.2.4 Dynamic Range and Step Attenuator Control 

Automation Xpress’s list mode prevents the step attenuator from switching automatically. However, this 
restriction is not applied when programming the 2400/2500 without Automation Xpress software.. Care 
should be taken whenever programming power lists for 2400/2500's equipped with Option 26 Step 
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Attenuator, 90 dB step attenuator installed. Operating a power list with the step attenuator set to automatic 
may cause excessive attenuator switching that can shorten the life the step attenuator. The maximum 
settable dynamic range with the step attenuator set to manual is 40 dB. Power levels in the list must be 
within a ±20 dB range of the manual step attenuator setting. When programming a power list, the step 
attenuator should be set to manual and set to the middle of the power list dynamic range. 
 

3.2.1.2.5 Create a List Using the List Controller Window 
The List Controller window provides access to the list parameters needed to operate the 2400/2500 in list 
mode. In addition to operational control, the List Controller also maintains list files stored in memory or 
on a storage media such as the controller hard drive. 
 
The List Table box located within the List Controller window displays lists you have created. You 
select a list from the List Table box to edit and to download to the 2400/2500. 
 
To begin creating a new list, a list name must be established first. You must have the List Controller 
window open to create a new list. If you already have a list file with a valid for-mat, skip this section and 
go directly to (“Running a List” section). Automation Xpress provides two methods for creating a new 
list. 
 
Naming a list is as follows. 

1. Open the List Controller window by selecting the OPERATION MENU dropdown and 
select>LIST CONTROLLER.  

2. Select> FILE MENU and select >NEW LIST.  
3. The Create a List dialog box will appear. Type a new list name in the List Label field and 

click>OK.  
 

 
Figure 9 Create a List window 

OR 
1. Open the List Controller window by selecting the OPERATION MENU dropdown and 

select>LIST CONTROLLER.  
2. In the List Controller window, place your mouse over the List Table box and right mouse click. 

Select >NEW LIST from the list pop up menu.  
3. The Create a List dialog box will appear. Type a new list name in the List Label field and 

click>OK.  
 
Once a new list name has been established, list point information can be added to the newly created list. 
Lists can be stored in the memory allocated by Automation Xpress or on your computers hard drive or 
any other valid storage medium. 
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3.2.1.2.6 Editing a List Point 
To edit a list point in the List Controller window, move your mouse over the list point and click on it. 
This will select and highlight the current list point to edit. 
 

 
 
Current List point field Selected point to edit 
 
The list point information will be displayed in the Current List Point field. You can make changes to the 
current list point by typing directly into this field. When you are finished editing the list point, the grayed 
out UPDATE button will become active and you can now click the UPDATE button to apply the change. 
 
New list points can be added before or after the list point in the Current List Point field by clicking on the 
ADD BEFORE or ADD AFTER buttons. Click on the UPDATE button to update the selected list point. 
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A list point can also be removed from the list by clicking on the DELETE button. Any time the list has 
been modified; it must be downloaded into the 2400. Once a list has been downloaded, the DOWNLOAD 
button will be disabled. Any change in the list editor window, triggering method, step attenuator state or 
delay setting will enable the DOWNLOAD button, indicating that a change has been made and the list 
must be downloaded into the 2400/2500. 
 
After a list is configured and editing is complete, the list must be downloaded from the Automation 
Xpress program to the 2400/2500 instrument. 
 

3.2.1.2.7 Create a List in the List Controller Window Tutorial 
The following example describes the creation of a simple list using the List Controller Window. The list 
will consist of 3 points with frequencies at 2, 8, 12 GHz. The power setting is 10 dBm for all points in the 
list. The first list point will also output a sync. signal. 
 

1. With the mouse over the List Table box, right click and select NEW LIST.  
2. Type LIST 2 in the List Label of the Create a List input box and click OK.  
3. Double click on the Frequency box in the Current List Point field and enter 2000  
4. Double click on the Power box in the Current List Point field and enter 10.  
5. Click on Add After to add the first list point to the new list. Add Before can also be used  
6. Repeat step 3 and enter 8000.  
7. Click on ADD AFTER to add the new point. Note that the power setting does not change from 

the last entered list point.  
 
The power setting does not change from the previous list point. The List controller maintains all 
information from the previous list point to reduce list point data entry. 
 

1. Click on the Sync Out checkbox to disable the sync. signal for this point  
2. Repeat step 3 and enter 12000. Click on Add After to add the new point  

 

3.2.1.2.8 Create a List Using the List Editor Window 
The List Editor window is used to create new lists, add new points to an existing list or delete one or more 
points in a selected list. The List Editor window provides a useful way to edit a range or add points to 
your current running list by step frequency or step power. You can edit or add a list point(s) to your 
current running list by specifying the start, stop, step, dwell time, and power level. 
 
The List Editor is used to quickly create simple lists where frequency and power is incremented or 
decremented in fixed steps. The list step is set using either a fixed step value or calculated by taking the 
difference between the start and stop points and then dividing the range by the number of requested 
points. The List Editor is used in conjunction with the List Controller, and permits new points to be added 
to or replace the list in the active list window. 
 
Configuring a frequency or level list range 
 
Configuring a frequency or level list range in the List Editor window requires three basic parameters: start 
parameter, stop parameter, and the frequency or level setting of all points in the new list range. 
 
Choose the list range type you wish to create by selecting between the BY FREQUENCY or BY POWER 
(dBm) option. 
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Type the value of the start parameter into the START PARAMETER field and select the appropriate unit. 
If you have selected to create a list with power as a parameter, all units displayed are measured in dBm. 
 
Type the value of the stop parameter into the STOP PARAMETER field. 
 
Enter the power level of the list range. 
 
The list step time can be set from within the List Editor window or the List Controller window at the time 
of the list download to the instrument. 
 
Setting the list step size 
 
You can set the list step size by directly entering a value into the Step Parameter field. The total number 
of points will be determined by the size of the step. The list size can also be set to a fixed number of 
points. The Increment Option field provides you with a choice of either method to set the list step size. 
 
From the INCREMENT OPTION field> click on the STEP option radio button. Selecting the STEP 
option will activate the STEP PARAMETER field of the List Range. When the STEP option is selected, 
the list will include the start and stop values plus the maximum allowable frequencies determined by the 
step size. The spacing between sequential list points will be equal with the exception of the last two list 
points if difference between the start and stop parameter is not evenly divided by the step parameter. 
 
From the INCREMENT OPTION field> click on the # OF POINTS option. Selecting the # OF POINTS 
option will activate the NUMBER OF LIST POINTS field. The list is created with a fixed number of 
points specified in the Number of Points field. The size of the step is determined by difference of the start 
and stop parameter divided by the number of points. The spacing between sequential list points will be 
equal. 
 
Setting the Replacement Type 
 
An existing list can replace or be inserted into the active list. The Replacement field pro-vides you with 
the option to replace the entire list or insert the new list information before or after a selected list point in 
the active list. When you want to insert a new list point(s) into the active list, select the desired list point 
in the active list window of the List Controller by clicking on the list point. 
 

1. Click REPLACE ALL to replace all list points with the new list information.  
 

2. Click INSERT BEFORE to insert the new list point(s) before the selected list point in the active 
list window of the List Controller.  

 
3. Click INSERT AFTER to insert the new list point(s) after the selected list point in the active list 

window of the List Controller. 
 
 
 

3.2.1.2.9 Create a List Example in the List Editor Window 
The following is a short example for creating a list using the List Editor window. The list will switch 
frequency starting at 2.0 GHz and stopping at 8 GHz. The frequency step size is 100 MHz, power level is 
set to +5 dBm and the step time is set to 1 msec. 
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Create a new list name by either selecting the file menu or right mouse click with the mouse in the List 
Table window of the List Controller window. 
 
Click on the BY FREQUENCY selection. 
 
Click on the REPLACE ALL selection. 
 
Click on the STEP selection 
 
Enter the following information: 
 

 Entry Field Value
   
  

 Start 2.0
  

 Stop 8.0
  

 Step 100
   

 Power (dBm) 5.0
   

 
The Units selections should be set to factory defaults. If not, use the GHz units for the start and stop 
fields. Use the MHz units for the step field. 
 

1. Enter 1.0 into the STEP TIME field.  
 

2. Click on the APPLY button  
 

3.2.1.2.10 Create a List Using Microsoft Excel or a Text Editor 
Automation Xpress list files are text-based files that conform to a very simple format. This enables you to 
generate list files using a text editor or spreadsheet software. All that is required is that the program must 
be capable of saving to a text file (.txt). 
 
List File Format 
 
A list file must be constructed to a format that Automation Xpress will recognize. If a list file is 
improperly structured, the list will not load into Automation Xpress.  
 
The first line of the text file defines the list Step time, RF Off time, Sync Out Delay and the step 
attenuator setting. The step attenuator setting is set in the 10 dB increments from 0 to 90 dB. The 
following rows correspond to the list points in the list. The first list point begins on row two of the text 
file. Each row defines the Sync Out Signal state, frequency, power, correction and dwell time settings. 
The parameters in the text file are separated with a comma, space, semi-colon or tab. A line feed (Enter 
key) is used to terminate each row in the list file. The following describes the list parameters in the text 
file. 
  <Step Time> <RF Off Time> <Sync Out Delay> <Step Attenuator> 
  <Sync State> <Frequency> <Power> <Correction> <Dwell time> 

   
Units are not included in the list file. The following table identifies the parameter unit type and range. 
Parameter Units Range
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Step Time milliseconds 0.15 - 1000 
RF OFF Time milliseconds 0.1 - 1000
Sync Out Delay milliseconds 0, 0.1 - 1000 
Step Atten dB 0 - 90
Sync State 1 or 0 1 or 0
Frequency MHz Min to Max frequency 
Power dBm Min to Max power 
Correction dBm Within the power limits 
Dwell Time milliseconds 0.15 - 1000 
 
Text File Example 
The list point step time is 2 msec., the RF Off time is 3 msec., Sync out delay is 1 msec., and the step 
attenuator (Option 26) is set to 10 dB. If Option 26 is not present, the value is set to 0. Each list point 
will output a sync signal. List point 1, 2, and 3 will have frequency settings of 100, 200, 300 MHz 
respectively. List point 1, 2, and 3 will have power settings of 0, 2, 4 dBm respectively. All points will 
be set to 0 dBm correction and 2 msec. dwell time. A space or tab delimiter is used to separate the list 
parameters in each line of the list text file. 
 

 
Figure 10 List file example 

 
The text file can be imported by using FILE MENU and selecting the OPEN FILE. If the file is correctly 
structured, the list will be loaded and a message will indicate that the list successfully loaded. The text file 
must be closed before it can be loaded into Automation Xpress. 
 

3.2.1.2.11 Running a List 
There are additional parameters that define how a list is triggered and how it will execute when a trigger 
is received. These parameters are set to factory default settings and can be modified to meet a wide range 
of applications requiring list operation.  This section will describe how to run a list and set the list 
parameters in details. 
 
Setting the Trigger Type 
 
Trigger type defines the source of the trigger that will execute the list 
 
External- This selection sets the list trigger to the external Trigger Input on the rear panel of the 
2400/2500. 
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GPIB- This selection sets the list trigger to GPIB. The IEEE 488.2 command *TRG is sent to the 
2400/2500 via GPIB to trigger a list. 
 
Group Execution- This selection sets the 2400/2500 to execute a list when a Group Executable Trigger is 
received via the GPIB. 
 
Setting the Repeat Type 
 
Repeat type defines how the list will sweep. Select one of the following: 
 
Single Step- This mode will switch one list point for every trigger received 
 
Single Sweep- This mode will execute the entire list when a single trigger is received. 
 
Continuous - This mode will execute the list and repeat until the list operation is aborted when a single 
trigger is received. 
 
Setting the Sweep Direction 
 
Sweep direction defines the direction of the list sweep. 
 
Forward- This setting causes the list to execute starting with the first point in the list and progress to the 
last point in the list. 
 
Reverse - This setting causes the list to execute starting with the last point in the list and progress to the 
first point in the list. 
 
Downloading a List 
 
Once a list has been loaded into Automation Xpress and all the necessary parameters have been edited, 
the list must be downloaded from the PC to the instrument. Click Download List button to download a 
list. 
 
Once a list has been downloaded, the Download List button will disable. Any parameter change in the 
current list or new list selection will require the new or modified list to be downloaded again. 
 
The Automation Xpress download operation uses a binary format to program the current list in 
Automation Xpress to the 2400/2500. Large lists will take several moments to download and compile. 
Using Automation Xpress's download provides a significant improvement 
 
Triggering a List 
 
After a list has been successfully downloaded, the 2400/2500 is ready for the list to be triggered. If either 
the GPIB or Group Execution is selected in the Trigger Type field, the Trigger button with enable after a 
successful list download has occurred. Click the TRIGGER button to initiate the list. 
 
Setting the step time, dwell time and Sync out Delay Time 
 
Step time is a setting that determines the time for each list point. It is a single setting and applies to all 
points in the list if the Global Stem Time selected under Step Time Type . The step time setting includes 
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the list point switching time and the dwell time at the point. List point switch time can vary according to 
the type of transition defined by the list point. If the individual Step Time is selected, it will enable Dwell 
time text box to allow a user to input Dwell time of selected list point. The settable range is 0.15 to 1000 
msec. 
 
Sync Out signal is a TTL signal that can be used to synchronize the list output with a measuring sys-tem 
such as a power meter or receiver. The Sync Out Delay is a setting that enables you to adjust the Sync 
Out signal with respect to a list point output. The sync. pulse occurs after the list point is executed at the 
specified delay setting. This is especially useful for measuring systems that use a Moving Average 
method in a measurement system. The Sync Out Delay must always be smaller than the List Step Time 
setting.  
 
List Operation Example 
 
The following steps describe a typical list operation. A valid list file named Example1.txt is loaded into the 
List Controller window. Repeat Type and Trigger Type and Sweep Direction are selected and the list is 
downloaded to the instrument. The instrument output is activated and the list is triggered to single sweep 
in the reverse direction via the List Controller window. 
 
From the List Controller window, move the mouse over the List Table field, right mouse click and select 
OPEN LIST. 
 
Select Example 1.txt and click OPEN.  
 
Click on SINGLE SWEEP in the Repeat Type field  
 
Click on GPIB in the Trigger Type field  
 
Click on the drop down arrow of the SWEEP DIRECTION and select REVERSE.  
 
Click on DOWNLOAD LIST button.  
 
Click on RF ON/OFF to activate the RF output  
 
Click on TRIGGER button. 
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3.2.1.3 Modulation 
Clicking on the Modulation Icon will expand the Modulation menu and display it's sub-items. An 
additional click will hide the Modulation sub-items. 

3.2.1.3.1 Amplitude Modulation (AM) 
Double clicking on the Amplitude Modulation icon will open the Amplitude Modulation window. The 
Amplitude Modulation window allows a user to enable or disable Amplitude Modulation. In addition the 
user can select an External or Internal Source. For an External Source the user can specify the AM Mode 
and the Scaling. For an Internal Source the user can specify the AM Mode, the Waveform, the Depth, and 
the Frequency. 
 

 
 

Figure 11 Amplitude Modulation window 

 
Name Description 
External Source Enable external AM source. If external source is enabled, all internal related controls are gray 

out. 
Sensitivity 
(External) Adjust the value of external sensitivity. 
Internal Source Enable internal AM source. If internal source is enabled, all external related controls are gray 

out. 
Waveform Select waveform option for internal AM. The available options are sine, triangle, ramp, 

square, and noise. 
Sensitivity 
(Internal) Adjust the value of internal sensitivity, and is only enabled when waveform is set to noise. 
Rate Adjust the value of internal Rate, and is only enabled when waveform is set to sine, triangle, 

ramp or square. 
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Depth Adjust the value of internal depth, and is only enabled when waveform is set to sine, triangle, 
ramp or square. 

AM ON/OFF Turn AM On/Off 
 

3.2.1.3.2 Frequency Modulation (FM) 
Double clicking on the Frequency Modulation icon will open the Frequency Modulation window. The 
Frequency Modulation window allows a user to enable or disable Frequency Modulation. In addition the 
user can select an External or Internal Source. For an External Source the user can specify the Sensitivity. 
For an Internal Source the user can specify the Deviation, the Waveform, and the Rate. 
 

 
Figure 12 Frequency Modulation window 

 
Name Description 
Mode Set Mode to Narrow or Wide. If unified FM is detected, Mode selection is hided. 
External Source Enable external FM source. If external source is enabled, all internal related controls are gray 

out. 
Sensitivity 
(External) Adjust the value of external sensitivity. 
Internal Waveform Enable internal FM source. If internal source is enabled, all external related controls are gray 

out. 
Waveform Select waveform option for internal FM. The available options are sine, triangle, ramp, and 
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square. 
Deviation Adjust the value of internal deviation, and is only enabled when waveform is set to sine, 

triangle, ramp or square.
Rate Adjust the value of internal Rate, and is only enabled when waveform is set to sine, triangle, 

ramp or square. 
DC FM Enable DC FM. 
FM ON/OFF Turn FM On/Off 
 

3.2.1.3.3 Phase Modulation 
Double clicking on the Phase Modulation icon will open the Phase Modulation window. The Phase 
Modulation window allows a user to enable or disable Phase Modulation. In addition the user can select 
an External or Internal Source. For an External Source the user can specify the Sensitivity. For an Internal 
Source the user can specify the Deviation, the Waveform, and the Rate. 
 

 
 

Figure 13 Phase Modulation window 

Name Description 
External Source Enable external Phase Modulation source. If external source is enabled, all internal related 

controls are gray out. 
Sensitivity 
(External) Adjust the value of external sensitivity. 
Internal Waveform Enable internal Phase Modulation source. If internal source is enabled, all external related 

controls are gray out. 
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Waveform Select waveform option for internal Phase Modulation. The available options are sine, 
triangle, ramp, and square. 

Deviation Adjust the value of internal deviation, and is only enabled when waveform is set to sine, 
triangle, ramp or square. 

Rate Adjust the value of internal Rate, and is only enabled when waveform is set to sine, triangle, 
ramp or square. 

PhM ON/OFF Turn Phase Modulation On/Off 
 
 

3.2.1.3.4 Pulse Modulation (PM) 
Double clicking on the Pulse Modulation icon will open the Pulse Modulation window. The Pulse 
Modulation window allows you to enable or disable Pulse Modulation. In addition, you can select an 
External or Internal Source. For an External Source, you can specify Polarity and sync out delay. For an 
Internal Source, you can specify the pulse width, sync out delay for Triggered, Continuous, and Gated 
modes. For each of these modes PRI, trigger polarity, and pulse delay can be specified depending on the 
mode of operation. For Internal Source, General and Burst Mode tabs are included. Burst Mode tab is 
hided if the burst mode is not enabled in the instrument. 
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Pulse Modulation with General Tab Selected Window 
 
 

 
Figure 14 Pulse Modulation - General tab window 

Name Description 
External Source Enable external PM source. If external source is enabled, all internal related controls are gray 

out. 
Polarity Set external Polarity to either Active High or Low 
SyncOut Delay Adjust value of external trigger delay. 
Internal Source Enable internal PM source. If internal source is enabled, all external related controls are gray 

out. 
General Tab Select this tab to show general pulse modulation internal data settings. 
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Continuous 
(PM Mode) 

Selecting this mode outputs a continuous train of pulses specified by the PRI and pulse width 
parameters. Continuous operation allows you to adjust the period of the pulsed RF output. 
Note: The period must be greater than the pulse width setting. Automation Xpress will 
automatically reset the pulse width to be lower than the period in cases where the period 
entered is less than the pulse width. 

Gated 
(PM Mode) 

Selecting this mode outputs a burst of pulses specified by the PRI and pulse width parameters 
for the duration of the gating signal. Gated operation allows you to generate a multiple pulse 
burst controlled by an external gate. This function allows you to control the pulse width, sync 
pulse delay, pulse repetition interval and trigger polarity of the pulse. The instrument will 
output a pulse train for the duration of the gating signal. If the gate signal is terminated after a 
pulse has been initiated, the instrument will complete the pulse burst specified by the pulse 
width.  

Triggered 
(PM Mode) 

Selecting this mode outputs one pulse per external trigger received following the sync delay. 
Triggered operation allows you to generate an RF pulse with a controllable pulse width and 
delay setting. The RF pulse is output after an external trigger is received and the delay time 
has been reached.  

PRI Adjust value of internal trigger PRI. 
Trigger In Set Trigger In to Active High or Active Low. 
Trigger Polarity Set the external trigger polarity to either Falling or Rising. 
Pulse Delay Adjust the pulse delay. 
Width Adjust value of internal pulse width. 
SyncOut Delay Adjust value of internal trigger delay. 
PM Leveling PM Leveling field is enabled if PM Leveling enabled in the instrument. 
Always On Set open loop PM to "Off" means PM leveling is always on. 
Off for pulse <1us Set open loop PM to "On" means PM leveling is off for pulse widths less than 1 us. 
PM ON/OFF Turn PM On/Off 
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Pulse Modulation with Burst Mode Tab Selected Window 
Burst Mode tab is enabled if the burst mode enabled in the instrument. Burst Mode tab is hided if the 
burst mode is not enabled in the instrument. 
 

 
Figure 15 Pulse Modulation - Burst Mode tab window 

 

Name Description 
Burst Mode Tab Select this tab to show pulse modulation internal burst mode data settings. Burst Mode tab is 

hided if the burst mode is not enabled in the instrument. 
PRI Adjust value of internal trigger PRI. 
Burst Period Adjust value of Burst Period. 
Number of pulse Adjust value of Number of pulse per burst. 
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per burst 
Continuous 
(PM Burst Mode) 

Selecting this mode outputs a continuous train of pulses specified by the PRI and pulse width 
parameters. 
 

Gated 
(PM Burst Mode) 

Selecting this mode outputs a burst of pulses specified by the PRI and pulse width parameters 
for the duration of the gating signal. 

Triggered 
(PM Burst Mode) 

Selecting this mode outputs one pulse per external trigger received following the sync delay. 
 

Trigger In Set Trigger In to Active High or Active Low. 
Trigger Polarity Set the external trigger polarity to either Falling or Rising. 
Pulse Delay Adjust the pulse delay.
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3.2.1.3.5 Scan Modulation 
Double clicking on the Scan Modulation icon will open the Scan Modulation window. The Scan 
Modulation window will automatically create a Scan Modulation List. The user can specify the following 
items for Scan Modulation setup: Power, Number of Lobes, Scan Time, and Frequency. By clicking the 
Apply button a Scan Modulation List is generated, loaded into the List Controller, and displayed 
graphically. 
 

 
Figure 16 Scan Modulation window 

 
Name Description 
Power (dBm) Set power in dBm. 
Number of Lobes Set the number of lobes in Scan. 
Scan Time Set the scan time. 
Frequency (MHz) Set frequency for the Scan. 
Scan Modulation 
Graph 

Display the waveform generated by the inputs 
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Apply button Apply all the input to create a list ramp or square.  If the List Controller window is not 
already opened, or if the list window is open and no list file is active in the list window, the 
list file creation window request you to enter a list file name. If a list is already active in the 
List Controller window, this action will automatically replace the current list in the List 
Controller. 

Points per cycle Display the number of points in every cycle 
Time per point 
(ms) Display the time taken for every point.
Number of points Display the number of list points generated in graph. 
Number of cycles Display the number of cycles in the graph. 
Power (mW) Display power in mW. 

 
Using Scan Modulation 
Scan modulation uses list mode to generate a SinX/X waveform. 
 

1. Double click on the Modulation Icon in the Navigation window to access the Scan Modulation 
window. Double click on the Scan Modulation icon to activate the Scan Modulation window.  

2. Enter the power level of the scan waveform in the Power field. This power setting is the highest 
level in the scan waveform.  

3. Enter the number of lobes of the SinX/X waveform. The number of lobes must be an odd integer 
from 1 to 49.  

4. Enter the scan time in milliseconds. The scan time is the total sweep time of the SinX/X 
waveform.  

5. Enter the frequency of the scan waveform in MHz.  
6. Click Apply to create a list that will generate the SinX/X waveform. If the List Controller 

window is not already opened, or if the list window is open and no list file is active in the list 
window, the list file creation window request you to enter a list file name. If a list is already 
active in the List Controller window, this action will automatically replace the current list in the 
List Controller window. 
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3.2.1.4 Advanced Settings 
Double clicking on the Advanced icon will open the Advanced Settings window. This window is used to 
choose ALC leveling selections. The available options are Internal, Power Meter, Positive Diode, and 
Negative Diode. Power Meter, Positive Diode, and Negative Diode selections are the external ALC 
Leveling. 
 

 
Figure 17 Advanced Settings window 
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3.2.2 System 

3.2.2.1 Interface 
The Interface window allows you to set the communications interface between the PC and the instrument. 
You can choose GPIB, RS-232 (serial port), USB or Ethernet cable. You can choose a specific GPIB 
address or a COM port or an IP address or you can allow Automation Xpress to automatically detect the 
2400/2500 on any of the communication interfaces. 
 

 
Figure 18 Interface window. 

 
Name Description 
Connection 
Interface 

Lets you select the cable connection used to connect your PC with the hardware device. 
 

GPIB Selecting the GPIB option will set the connection through the GPIB interface. 
      Switch Address Lets you switch to another 2400/2500 if it is connected to the PC via one of the 
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communications interfaces. 
      Set Address Lets you change the GPIB address of the 2400/2500 that is connected via the GPIB interface. 

You must click APPLY for the new address to be set.
Serial Port You can select from COM 1 through 30. The COM port selection must be a valid port with a 

synthesizer connected to the port. The port connection can be an adapted USB or RS-232. 
      COM Port Lets you select the COM Port. 
      Baud Rate Lets you select the baud rate. 115200, 38400, 19200 or 9600 baud rate can be selected. 

115200 is he current default setting. 
      Data Bits Lets you select the data bits. There are two options: 8 and 7. “8” is the current default setting. 
      Parity Lets you select the data bits, which has three options: Odd, Even and None. “None” is the 

current default setting.
      Stop Bits Let’s you select the data bits, which have two options: 1 and 2. “1” is the current default 

setting. 
Ethernet You can select an IP address. 
      IP Address Let you select an IP address. 
USB You can select from COM 1 through 30 via a USB cable. The COM port selection must be a 

valid port with a synthesizer connected to the port. 
      Port Let you select a USB COM port. 
Auto Connection This option automatically detects any 2400/2500 synthesizer connected to the PC through the 

GPIB, RS-232, USB and/or Ethernet. This feature can be used when the address or 
connection type to the 2400/2500 is not known. This feature will take a few moments to 
search all available connections. 

Demo Mode Automation Xpress will run in the demonstration mode as if a 2400/2500 was connected to 
the controller. Some features such as Auto-Programming will not function because they 
require a 2400/2500 to complete the communication process. 

Apply Clicking the Apply button will apply the selected cable connection options. 

 



                                  

 Page | 50 33486 Rev.C / US090922  

3.2.2.2 General Information 
The General Information window provides important information about your current Microwave 
Synthesizer. The General Information window describes your current model, serial information, current 
firmware version, and hardware specifications 
 

 
Figure 19 General Information window 
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3.2.3 Tools 

Clicking the Tools icon in the navigation window will open the Tools menu with all of its icons 
displayed. An additional click will hide the Tools sub-items. 

3.2.3.1 Command Interpreter 
The Command Interpreter window allows you to directly input GPIB commands or load the script 
command(s) from a file and send the commands to the instrument. The commands in the Command 
window can be executed by double clicking on the command or by highlighting it and pressing the 
ENTER key. The commands can be executed in the order of input, starting with the command at the top 
of the Command Window. A sequence of commands in the Command Window can run once or in a 
continuous loop. 
 Command window    Command entry 
 

 
Figure 20 Command Interpreter window 

Message window 
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Name Description 
Language Lets you select between SCPI (Standard Commands for Programmable Instruments) or GT12000 

command format. 
Command Window Displays function calls or commands.  A double click on any of the commands in this window will 

send the selected command to the instrument.
Show Commands Checking this box will display the sent command before the returned message 
Message window This window displays all the returned messages from the instrument. If the “Show Commands” 

checkbox is checked, this feature will then display both the command and the returned message for 
the corresponding command.

Halt on Error Checking this box will stop the execution when an error is detected.
Log Msg Checking this box to let you save the returned message to a file.
Clear Msg button Clicking this button clears all the returned messages.
Command Entry Lets you add new commands to the Command window. Text entered in this window is automatically 

copied to the Command window.
Run Once Clicking this button executes the command sequence in the Command window, starting from the 

first command or from the selected command to the end.
Loop button Lets you execute the sequence in the Command window continuously.
Abort button Pressing this button will abort the looping feature. Only enabled when the “Loop” button is clicked.
Single step Click button to execute the single command. Let you execute the command sequence in the 

Command window, starting from the first command or from the selected command to the end. 
Delay text box Allow you to set a delay time between commands in the Command window. 
Loop No text box Clicking this button executes the command sequence in the Command window, starting from the 

first command or from the selected command to the end.
Load button Lets you load script(s) to the Command window from a file.
Save button Lets you save the script in the Command window to a file.
Advanced button Click button to pop up the Connection Selections window. Select GPIB or serial port cable. 

Click OK button to connect the Command Interpreter window to the selected connection and 
set AX to Demo Mode (no connection).  

 

3.2.3.1.1 Entering Commands in the Command Interpreter  
The default language for the instrument is SCPI. The Command Interpreter does not automatically control 
the instrument command set interface. The command language can be change to SCPI or GT12000 
(Native) in the Command Interpreter using either the /SCPI or / GT12000 command. There are no query 
commands to determine which command interface the instrument is set to. 
 
Manual Entry Method. Move the mouse over the Command Entry field and left click. Type the command. 
The text will automatically be copied in the Command Window. The Command Entry field functions like 
any text editor and commands can be edited using techniques such as overwrite, replace, insert. 
 
Performing a Query. Enter "????" (four question marks) in the Command Entry field. Instrument 
responses are displayed in the Message Window. 
 

3.2.3.1.2 Executing Commands in the Command Window 
The Command Interpreter enables you to execute commands as a sequence or individually. A command 
sequence can be executed in a single run or can be executed in a continuous loop. 
 
Double click on a command in the Command Window to execute a single command. Using this method, 
the commands in the Command Window can be executed in any order. 
 
Click RUN ONCE to execute the commands shown in the Command Window. AX executes commands 
starting with the first command and progresses through the command list to the last command in the 
sequence. 
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Click LOOP to execute the commands starting with the first command, progressing to the last command 
in the sequence and repeating until the action is aborted. 
 
The Abort button will become active when the Run Once or Loop buttons are selected. Click on the 
ABORT button to terminate a command sequence operation. 
 
Click Single Step to execute the single command. Let you execute the command sequence in the 
Command window, starting from the first command or from the selected command to the end. 
 
The Command Interpreter also allows you to set a programmed delay between commands. 
 
Click on the DELAY CONTROL and enter a command delay time in milliseconds. The maximum delay 
setting is 9999 milliseconds. 
 

3.2.3.1.3 Messages 
The Message Window displays information regarding commands sent to the instrument and any query 
information returned from the instrument. The message feature also allows you to halt a command 
sequence when an error or invalid remote operation has occurred. The message feature will also let you 
save the message history to a file. 
 
Click the SHOW COMMANDS option to display commands sent to the instrument and any information 
returned from the instrument in the form of a query Click the HALT ON ERROR option to stop a 
sequence run whenever a remote operation error is encountered, such as a communications failure. This 
feature does not interrupt the command sequence if an invalid command is encountered. 

3.2.3.1.4 Messages Loading, and Saving a Command Sequence 
Along with directly entering a command sequence into the Command Interpreter, a command sequence 
can be loaded into the Command Interpreter from a text file. The only requirements to properly load a text 
file into the Command Interpreter, is the command(s) must be syntactically correct and each line must 
consist of one command and terminated with a line feed. All text editors automatically add a line 
termination each time the Enter key is pressed. 
 

3.2.3.1.5 Loading a text script file into the Command Interpreter 
To load a text script file into the Command Interpreter window, perform the following: 
 
Click on the Load button. An Open Script browser window will appear and you will be prompted to select 
a file to load. Select the appropriate file and click on the Open button. 
 
 



                                  

 Page | 54 33486 Rev.C / US090922  

3.2.3.2 Auto-Programmer for SCPI/Native Script 
Double clicking on the Auto Programmer for SCPI/Native Script icon will open the Auto Programmer 
window for SCPI/Native Script. As long as the Auto Programmer for SCPI/ Native Script window is 
open, the operations on the Control Package are recorded. You can select between SCPI and 
GT12000(Native) Script. When you have finished, you can export the code to a file or clear the recorded 
actions. 
 

 
    Figure 21 Auto-Programmer - SCPI/Native Script window 

 
Name Description 
Language Interface 
Option 

Lets you generate command scripts of the operations performed in Automation Xpress.  
 

      SCPI Automation Xpress will capture the SCPI commands as they are executed. 
      GT12000 Automation Xpress will capture the GT12000 (Native) commands as they are executed. 
Save Command 
checkbox 

Lets you save the command script before exporting. The default option is checked. 
 

Command capturer 
box 

Displays the executed commands. 
 

Export to File Clicking this button exports the commands shown in the Command Capturer box to a file. 
Clear Message Clicking this button will clear the function calls or commands displayed in the Command capturer 

box. 
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3.2.3.3 Auto-Programmer for MS Visual C++ 
Double clicking on the Auto Programmer for VC++ icon will open the Auto Programmer window for MS 
VC++ window. As long as the Auto Programmer for VC++ is open, the operations on the Control 
Package are recorded and translated into code at your choice. You can select between SCPI and 
GT12000(Native) Script. When you have finished, you can export the code to a file or clear the recorded 
actions. Auto Programmer for VBasic is similar to Auto Programmer for VC++.  
 
Please refer to GT2400 and 2500 Series Microwave Signal Generators Programmer Manual for the 
Dynamic Link library or DLL functions details. 
 

 
Figure 22 Auto Programmer for VC++ window 

 
Name Description 
Save Command 
Script checkbox 

Checking this box will automatically save the command script when the Auto-Programmer window is 
closed. 

DLL Function Calls Displays the AX DLL function calls.
Export to File Clicking this button to export DLL function calls to a text file.
Clear Clicking this button to clear DLL function calls.
Create Project Clicking this button will open the Create Project window. It is used to create the Microsoft Visual 

C++ project with the recorded DLL function calls.
Add Delay Click Apply button to add Sleep(xxxx) ms delay to DLL functions.
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Add Comment Click Apply button to add comment to DLL functions.

3.3 Service Tab Windows 
Clicking on the Service menu tab in the Navigation window 3.1.4 will open the Service menu. When the 
Service menu displays, the Service menu icons will appear in the Navigation window as follows. 
 

 
Figure 23 Navigation window - Service tab 
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3.3.1 Test 

Clicking the Test icon in the navigation window will open the Test menu with all of its icons displayed.  
 

3.3.1.1 LCD Test 
Double clicking the LCD Test icon will open the LCD test window. From this window you can select and 
run one of the following tests: All, Horizontal, Diagonal, None, and Off.  
 

 
Figure 24 LCD Test window 

 
Name Description 
All Turns on all pixels on the GT2400/2500 display.
Horizontal Turns on pixels to form horizontal lines on the unit display.
Diagonal Turns on pixels to form diagonal lines on the unit display.
None Turns off all pixels on the unit display.
Off Turns all LCD tests off. 
Test Click Test button to start the test.
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3.3.1.2 SCPI Status Reporting 
Clicking the SCPI Status Reporting Menu icon in the Navigation window will open the SCPI Status 
Reporting window. This window is used to do the Status Report settings. 
 

 
Figure 25 SCPI Status Reporting window 
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3.3.2 Tools 

Clicking the Tools icon in the Service tab menu of the Navigation window will open the Tools menu. 
Opening the Tools menu will display the Tools sub-menus.  
 

3.3.2.1 Firmware Download 
Double clicking the Firmware Download icon will open the Firmware Download window. This window 
allows you to download the firmware files via the Serial port, USB with COM port selected, GPIB or 
Ethernet. An appropriate COM port or GPIB address or Ethernet IP address must be selected. Click 
Download File button and select a firmware file with chk extension to download the firmware to the 
instrument. 
 
The firmware version should be 4.5 or above for USB/GPIB/ Ethernet firmware download. If the 
instrument firmware version is lower than 4.5, please use the serial port for the firmware download. 
 

 
Figure 26 Firmware Download window 
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Giga-tronics Support Services 
 
At Giga-tronics, we understand the challenges you face. Our support services begin from the 
moment you call us. We help you achieve both top-line growth and bottom-line efficiencies by 
working to identify your precise needs and implement smart and result orientated solutions. We 
believe and commit ourselves in providing you with more than our superior test solutions. 
 
 

For technical support, contact: 
Tel: 1-800-726-GIGA (4442) or (925) 328-4669 

Email: support@gigatronics.com 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


